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Introduction 
 
The Sage Euro Conversion tool enables you to convert your Sage Line 50 V9 or V11 

transactions (client and supplier accounts, invoices, sales and purchase orders etc) to the 
respective EURO equivalents. The conversion process is simple: select your Sage Line 50 

dataset, configure your parameters (Sage Version, username and password) and then click 
on the convert button. It is important that you backup your Sage Line 50 dataset before 

converting your data. This enables you to restore your pre-conversion data whenever this 

may be required. 
 

The Sage Euro Conversion tool also includes two additional features which can be used to 
post single-entry transactions as well as fix minor inaccuracies within the customer, supplier 

and nominal account balances. Single-entry transactions may be required in case Sage Line 
50 reports that the trial balances do not match. 

 
The account balance adjustment routine is an automated process which can be used to 

adjust minor inaccuracies within customer, supplier and nominal account balances. These 

inaccuracies are a result of the decimal precision used during the conversion process as well 
as the applicable EURO conversion rate. 

 
This user guide was written as complete reference for the sage line 50 EURO conversion 

tool. It includes an overview of the interface, instructions on how to use the tool, a 
thorough explanation of the tool’s core functionality, and a number of walkthroughs 

exploring the product’s features. 
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License Agreement 
 
IMPORTANT – PLEASE READ THE TERMS OF THIS SOFTWARE LICENSE AGREEMENT (“AGREEMENT”) CAREFULLY.  
BY USING THIS PRODUCT, YOU AGREE TO BE BOUND BY THIS AGREEMENT.   
 
IF YOU DO NOT AGREE TO ANY OF THE TERMS OR CONDITIONS BELOW, YOU SHOULD DISCONTINUE THE 
INSTALLATION OR DOWNLOAD PROCESS. 
 
This is a legal agreement between you and Garsys Software for the accompanying software product, which may 
include associated media, printed materials, “online” or electronic documentation, and modifications, updates, 
and enhancements provided by Garsys Software (the “Licensed Software”).  The term “you” means the individual 
person installing or using the Licensed Software on his/her own behalf; or, if the Licensed Software is being 
downloaded or installed on behalf of a company, “you” means that company and the person downloading or 
installing the Licensed Software, who represents that he/she has the authority to do so on the company’s behalf. 
 
The Sage Euro Conversion Tool software is available in a commercial and an evaluation version.  Both the 
commercial and the evaluation versions are subject to the terms and conditions of this Agreement. The 
commercial version of the software requires payment by you of a license fee.  The evaluation version of the 
software is the only version that is provided without charge.  The evaluation version is not free software and is 
subject to the restrictions set forth below. 
 
UPON ORDERING, DOWNLOADING, INSTALLING OR UNENCRYPTING ANY VERSION OF THE SOFTWARE, YOU ARE 
REAFFIRMING THAT YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT 
 
1. License.  Subject to the terms of this Agreement, Garsys Software grants you a non-transferable, non-

exclusive, worldwide, limited license to reproduce, execute, and perform the Licensed Software, in executable 
object code format only, as necessary to install the Licensed Software. One copy of the Sage Euro Conversion 
Tool may either be used (1) by a single person who uses the software personally on one or more computers, 
or (2) by multiple people non-simultaneously on a single workstation, but not both.  

You may access the commercial version of the Sage Euro Conversion Tool through a network, provided that 
you are the only person who may use the software or you have obtained individual licenses for the software 
covering all workstations that will access the software through the network. For instance, if eight different 
workstations will access the software on the network, each workstation must have its own license, regardless 
of whether the workstations access the software at different times or concurrently. 
 
You may receive the software and related documentation in more than one medium. Regardless of the 
number of media you receive, you may use only the medium that is appropriate for the workstation on which 
the software is to be installed.   

 
If the software and related documentation are provided as an upgrade, patch or update to an earlier licensed 
release of the software, then you must have a valid license to operate such earlier release of the same version 
as the upgrade to install or use the upgrade. All software being upgraded is deemed to be part of the software 
and is subject to this Agreement. You may transfer an upgrade only in conjunction and together with the 
licensed software being upgraded. 
 
You may make one (1) copy of the Licensed Software for backup and archival purposes, provided that you 
reproduce all copyright and other proprietary notices that are on the original copy of the Licensed Software. 

 
2. Restrictions.  The rights granted to you in this Agreement are subject to the following restrictions: (a) you 

shall not license, sell, rent, lease, transfer, assign, distribute, display, host, outsource, disclose or otherwise 
commercially exploit or make the Licensed Software or the Service available to any third party (other than an 
authorized User); (b) you shall not modify, make derivative works of, disassemble, reverse compile or reverse 
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engineer any part of the Licensed Software or the Service, access the Licensed Software in order to build a 
similar or competitive product or service, or authorize any third party to do any of the foregoing; (c) except as 
expressly stated herein, no part of the Licensed Software may be copied, reproduced, modified, distributed, 
republished, downloaded, displayed, posted or transmitted in any form or by any means, including but not 
limited to electronic, mechanical, photocopying, recording or other means; and (d) any future release, update, 
or other addition to functionality of the Licensed Software shall be subject to the terms of this Agreement. 

 
3. Ownership.  The Licensed Software is licensed, not sold, to you for your use only under the terms of this 

Agreement, and Garsys Software reserves all rights not expressly granted to you. You own the media, if any, 
on which the Licensed Software is recorded, but Garsys Software retains ownership of all copies of the 
Licensed Software itself. 
 

4. DISCLAIMER OF WARRANTIES.  THE LICENSED SOFTWARE AND THE SERVICE IS PROVIDED “AS-IS.”  FOR THE 
COMMERCIAL VERSION OF THE LICENSED SOFTWARE GARSYS SOFTWARE WARRANTS THAT THE PHYSICAL 
MEDIA AND THE DOCUMENTATION WILL BE FREE FROM DEFECTS IN MATERIALS AND WORKMANSHIP UNDER 
NORMAL USE FOR 90 DAYS FROM THE DATE OF DELIVERY TO YOU. GARSYS SOFTWARE ALSO WARRANTS 
THAT THE COMMERCIAL VERSION WILL BE FREE FROM SIGNIFICANT DEFECTS THAT PREVENT THE SOFTWARE 
FROM PERFORMING SUBSTANTIALLY IN THE MANNER DESCRIBED IN THE USER MANUAL FOR A PERIOD OF 90 
DAYS FROM THE DATE OF DELIVERY TO YOU.  AT GARSYS SOFTWARE’S OPTION, GARSYS SOFTWARE’S SOLE 
RESPONSIBILITY SHALL BE (I) TO REPLACE DEFECTIVE MEDIA OR DOCUMENTATION, AS THE CASE MAY BE, (II) 
TO USE REASONABLE EFFORTS TO CORRECT SIGNIFICANT DEFECTS IN THE SOFTWARE WITHOUT CHARGE, OR 
(III) TO REFUND THE LICENSEE FEE PAID TO GARSYS FOR THE APPLICABLE COPY OF THE SOFTWARE AND 
TERMINATE ALL LICENSES GRANTED TO YOU FOR SUCH COPY. ANY REPLACEMENT SOFTWARE WILL BE 
WARRANTED FOR THE REMAINDER OF THE ORIGINAL WARRANTY PERIOD OR 30 DAYS, WHICHEVER IS 
LONGER. GARSYS SOFTWARE AND ITS SUPPLIERS DISCLAIM ALL EXPRESS, IMPLIED OR STATUTORY 
WARRANTIES RELATING TO THE LICENSED SOFTWARE AND THE SERVICE, INCLUDING BUT NOT LIMITED TO, 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT. GARSYS SOFTWARE 
DOES NOT WARRANT THAT USE OF THE LICENSED SOFTWARE OR THE SERVICE WILL BE UNINTERRUPTED, OR 
ERROR-FREE, OR THAT DEFECTS WILL BE CORRECTED.  IF APPLICABLE LAW REQUIRES ANY WARRANTIES WITH 
RESPECT TO THE LICENSED SOFTWARE OR THE SERVICE, ALL SUCH WARRANTIES ARE LIMITED IN DURATION 
TO NINETY (90) DAYS FROM THE DATE OF DOWNLOAD.   

 
5. LIMITATION OF REMEDIES AND DAMAGES.  IN NO EVENT WILL GARSYS SOFTWARE BE LIABLE FOR ANY 

CONSEQUENTIAL, INDIRECT, EXEMPLARY, SPECIAL OR INCIDENTAL DAMAGES, INCLUDING ANY LOST DATA 
AND LOST PROFITS, ARISING FROM OR RELATING TO THIS AGREEMENT. GARSYS SOFTWARE’S TOTAL 
CUMULATIVE LIABILITY IN CONNECTION WITH THIS AGREEMENT, WHETHER IN CONTRACT OR TORT OR 
OTHERWISE, WILL NOT EXCEED THE FEES PAID TO GARSYS SOFTWARE HEREUNDER. ONE OR MORE CLAIMS 
WILL NOT ENLARGE THIS LIMITATION. THE PARTIES ACKNOWLEDGE THAT THE PROVISIONS OF THIS SECTION 
5 REFLECT AN AGREED-UPON ALLOCATION OF RISK BETWEEN THE PARTIES AND THAT THE PARTIES WOULD 
NOT ENTER INTO THIS AGREEMENT WITHOUT THESE LIMITATIONS OF LIABILITY. IN ADDITION, GARSYS 
SOFTWARE DISCLAIMS ALL LIABILITY OF ANY KIND OF GARSYS SOFTWARE’S SUPPLIERS. 

 
6. Term and Termination.  If you have acquired an evaluation version, the license granted herein shall 

automatically terminate fifteen (15) days after you first install such version. Subsequent downloads; 
installations or use of the evaluation version by or for you will not extend, renew, or otherwise restart the 
term of the license.  The license granted for the commercial version will continue until it is terminated.  This 
Agreement and the licenses granted hereunder are effective on the earlier of the date you download or install 
the Licensed Software and shall continue for the period for which you have paid the applicable fees unless this 
Agreement is terminated by either party pursuant to this section. This Agreement will terminate immediately 
in the event that you materially breach any of the terms hereof. You may terminate this Agreement at any 
time, with or without cause, by sending either an email to support@garsys.com or to such other address as 
Garsys Software may specify in writing by posting the new address on Garsys Software’s website.  Upon 
termination of the Software license(s) the terms of this Agreement which are intended to survive termination 
will remain in effect. 

 
7. Modifications.  Garsys Software reserves the right to change the terms and conditions of this Agreement or its 

policies relating to the Licensed Software at any time, and such changes will be effective upon notice to you.  
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Your continued use of the Licensed Software after any such changes shall constitute your consent to such 
changes. 

 
8. Miscellaneous.  Neither the rights nor the obligations arising under this Agreement are assignable by you, and 

any such attempted assignment or transfer shall be void and without effect. This Agreement shall be 
governed by and construed in accordance with the laws of Malta without regard to the conflict of laws 
provisions therein. In the event that any provision of this Agreement is found to be contrary to law, then such 
provision shall be construed as nearly as possible to reflect the intention of the parties, with the other 
provisions remaining in full force and effect. Any notice to you may be provided by email. This Agreement 
constitutes the entire agreement between the parties pertaining to the subject matter hereof, and any and all 
written or oral agreements previously existing between the parties are expressly cancelled. Any modifications 
of this Agreement must be in writing and agreed to by both parties.  

 
QUESTIONS OR ADDITIONAL INFORMATION.  If you have questions regarding this Agreement, or wish to obtain 
additional information, please send an e-mail to support@garsys.com. 
 

THE LICENSED SOFTWARE IS PROTECTED BY MALTESE COPYRIGHT LAW  
AND INTERNATIONAL TREATY.   

UNAUTHORIZED REPRODUCTION OR DISTRIBUTION IS SUBJECT TO CIVIL AND CRIMINAL PENALTIES. 
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Compatibility and System Requirements 
 

The sage EURO conversion tool is only compatible with the following Sage Line 50 versions: 

 
- Sage Line 50 v9 

- Sage Line 50 v11 
 

 
The minimum system requirements for installing and running the sage EURO conversion 

tool are as follows: 
 

- Microsoft Windows 98/2000/XP (XP recommended) 

- Microsoft .NET Framework 2.0 
- 128Mb of RAM 

- Sage Line 50 v9 or v11 (must be installed on the same computer where the data 
conversion will be done) 

- Internet connection (required for the license activation process) 
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Installation 
 

To install the sage line 50 EURO conversion tool, locate the package downloaded from our 

website and then double click on the file named setup: 
 

 
 
This will initiate the installation process which only requires minimal intervention from your 

end.  
 

Microsoft .NET Framework v2.0 
The sage EURO conversion tool requires Microsoft’s .NET Framework version 2.0. If this is 

not detected during the setup process, you will be prompted to install the required files. 

This process requires you to be connected to the internet. 
 

Once the installation utility verifies that all the required components are available, the 
following screen will be displayed: 
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To continue with the installation, click on the Next button. You are now presented with the 

license agreement screen. If you want to continue with the installation and use the sage 
EURO conversion tool, you need to select the I Agree option and then click on the Next 

button. Otherwise, click on Cancel to cancel the installation process. 
 

 
 
 

On the next screen you need to select the target folder where the Sage EURO Conversion 
Tool will be installed as well as whether you’d like the tool to be accessible to other users 

who may use your computer. 
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Once you’re done with these selections, click on the Next button. To start the actual 

installation process, click on the Next button. 
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Once the Sage EURO Conversion Tool installation is complete, you can launch the program 

either by clicking on the Sage Euro Conversion Tool icon located on your computer 
desktop or by click on the Start button, then selecting All Programs and then Sage Euro 

Conversion Tool. 
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Interface 
 
The Sage Euro Conversion Tool has a minimal yet intuitive interface – emphasis is placed 

where it belongs – the actual data conversion process. 
 

 
 
 

The Conversion Settings section provides you with the option to change the parameters 

which are used for the actual data conversion. You can change the conversion rate (the 
official conversion rate is 0.429300), the conversion type (Maltese lira to € or vice versa) as 

well as the decimal precision to use during the conversion. 
 

A note on decimal Precision and Sage Line 50 
Sage Line 50 v9 and v11 use a decimal precision of 2 decimal places. By increasing the 

decimal precision you may attain further accuracy during the data conversion process but 
may get data inconsistency warnings within Sage due to the rounding mechanism applied 

by sage. USE THIS OPTION WITH EXTREME CARE. 
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License Activation 
 
Certain features of this program (e.g. the conversion function) require a valid and activated 

license. You may activate your license automatically by clicking on the License tab and then 
on the Activate button. Moreover, the license will determine the number of Sage Line 50 

companies (datasets) that may be converted with this tool. 
 

To activate your license, click on the License tab and then enter the product key provided 

by Garsys Software. Then click on the Activate button to automatically activate the 
product.  

 

 
 

Automatic activation requires a connection to the internet. 
 

Users without internet access 
If you don’t have internet access on the PC where the Sage EURO Conversion Tool will be 

installed, you can manually activate the product by following these steps: 
 

1. Click on the Generate License ID button 

2. Click on the Copy License ID button. This will copy the generated license id to 
the clipboard so that you can email/print the license id and then send it to us 

3. Once you receive your activation key, de-select the Automatic License 
Activation option and then paste the activation key in the activation key 

textbox. 
4. Click on the Activate button. 
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Pre-Conversion Tasks 
 
Before converting your Sage Line 50 v9 or v11 data, it is recommended that you perform 

the following tasks: 
 

1. Backup your Sage Line 50 data. 
 

2. Check your Sage Line 50 data for errors. To do this, while you’re logged in Sage 

Line 50 select the Maintenance option from the File menu and then click on the 
Check Data button. If any errors are reported by Sage, then click on the Fix 

button. 
 

3. If possible, it is recommended that you do a period-end (month-end or year-
end). To do this, select the respective option within the Period End option 

located within the Sage Line 50 Tools menu or consult your financial controller. 
 

4. Take another backup of your Sage Line 50 dataset following the data 

maintenance process. 
 

5. Store the backups in a safe place in case you may need these following the data 
conversion process. 

 
6. Take note of a sample of your customer balances, supplier balances, cash and 

bank accounts and trial balance totals. 
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Configuration 
 
Before converting your Sage Line 50 dataset, you need to configure the Sage EURO 

Conversion Tool by confirming and/or providing the following parameters: 
 

- EURO conversion rate (official rate is 0.429300) 
- Conversion type (Lm to € or € to Lm) 

- Decimal precision (default value set to 2 decimal places) 

- Sage username for the dataset being converted 
- Sage password for the dataset being converted 

- Sage Line 50 Version (v9 or v11) 
- Sage installation folder (usually C:\Program Files\Sage\Accounts\) 

 
Before configuring these parameters, please make sure that Sage Line 50 is not running. 

To configure these parameters, click on the configuration tab: 
 

 
 

1. Select the decimal precision (if required); 
2. Type in your Sage Line 50 username; 

3. Type in your Sage Line 50 password; 
4. Select your Sage Line 50 version (to confirm your Sage Line 50 Version, open Sage 

Line 50, then select the About option from the Help menu; 
5. Select your Sage Line 50 installation folder by clicking on the Browse button; 

6. Populate the list of companies by clicking on the List Companies button. 
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If all the parameters are correct you should now see a list of your Sage datasets and the 
respective Sage version required to open/convert the dataset. 

 
The number of companies displayed in the list of companies depends on your Sage EURO 

Conversion Tool license (single or multi user). Therefore, if you’ve purchased a single 
company license, then only one company will be listed by the Sage EURO Conversion Tool. 

 
To test the connection between the Sage EURO Conversion Tool and your Sage Line 50 

dataset, click on the Test Connection button. If the connection is successful, you will 

receive the following notification: 
 

 
 

Otherwise, if the Sage EURO Conversion Tool cannot connect to your sage line 50 dataset, 

you will receive a notification similar to the following: 
 

   
 
 

In such cases, please ensure that all parameters are correct and that you can successfully 

connect to your sage line 50 dataset before attempting the actual conversion process. 
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Converting your Sage Line 50 data 
 
The actual data conversion process is quite straightforward. To proceed with the data 

conversion process, first click on the Euro Conversion tab. 
 

 
 

You should be able to see the list of your companies similar to that displayed on the 
configuration screen. 

 

Now click on the Preview button to see an overview of the number of records that will be 
converted. The information displayed by the preview option is for information purposes 

only – in fact, the actual number of records processed during the data conversion process 
may be more than the number of records displayed by this option. 

 
Once you are ready to convert your sage line 50 data: 

 
- Ensure that you have an adequate and recent backup of your sage line 50 data 

- Click on the convert button 

 
The time taken by the data conversion process depends on the number of records 

(customers, suppliers, purchase and sales invoices, audit trail etc) stored within your sage 
line 50 dataset. 

 
A notification will be displayed once the data conversion process is complete. You will also 

be notified of any issues which are discovered during the data conversion process. 
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Post-Conversion Tasks 
 
Following the data conversion process, it is recommended that you perform the following 

tasks: 
 

1. Backup your Sage Line 50 data using a different backup file name. 
 

2. Check your Sage Line 50 data for errors. To do this, while you’re logged in Sage 

Line 50 select the Maintenance option from the File menu and then click on the 
Check Data button. If any errors are reported by Sage, then click on the Fix 

button. (see note below) 
 

3. Store the backups in a safe place in case you may need these following the data 
conversion process. 

 
4. Take note of the same sample of your converted customer balances, supplier 

balances, cash and bank accounts and trial balance totals which you previously 

captured before the actual data conversion process. 
 

5. Compare the converted balances and totals with the pre-conversion balances and 
totals using the official conversion rate of 0.429300. 

 
6. Change your company’s base currency description to EURO. To do this, open 

your Sage Line 50 company data, select the Currencies option from the 
Settings menu, select the BASE currency and click on the Edit button. Now 

replace the currency name with EURO and then click on OK and then on the 

CLOSE button. 
 

 

Changing Sage Line 50’s base currency 
 

To change Sage Line 50’s base currency, please follow these steps: 
 

1. In Sage Line 50, select the Currencies option from the Settings menu. 
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2. Select the currency which has its exchange rate set to BASE (this is normally 

selected by default). 
 

3. Click on the Edit button. 
 

4. Enter EURO as the Currency name. 
 

5. Enter EUR as the Currency Code. 
 

6. Enter € (the EURO symbol) as the Currency symbol. The € symbol is usually 

accessible by pressing the Alt-Gr and 4 (€) keys simultaneously. 
 

 
 
7. Click on OK. 

 
 

Post-conversion warnings/errors reported by Sage 
 

Sage Line 50 may report a number of errors/warning following the conversion process. 
These mainly include errors/warnings similar to those displayed below: 

 

 
 
Moreover, Sage Line 50 may also complain that the nominal and trial balances are incorrect 

or do not match. 
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These errors/warnings are mainly due to the conversion rate used during the conversion 

process. The inconsistencies between the allocation totals and related splits are due to the 
rounding mechanism used by Sage Line 50 and shouldn’t reflect any real problems within 

your Sage Line 50 dataset. 
 

To correct the errors/warnings related to the nominal and trial balances can be fixed using 
the single entry journal posting utility as explained in the following section. 

 
  



21 | S a g e  E u r o  C o n v e r s i o n  T o o l  U s e r  G u i d e  
 

 

Posting Single Journal Entries 
 
The Single journal entry posting utility is used to correct the minor inaccuracies within the 

nominal and trial balances reported by Sage Line 50. 
 

 
 
To post a single journal entry: 

 

1. Determine the difference in nominal/trial balances as reported by Sage Line 50 
by generating a trial balance and calculating the difference between the totals. 

 
2. Click on the Nominal A/C where the single journal entry will be posted. 

 
3. Select the Transaction Type (Select DR to post a debit transaction or CR to 

post a credit transaction). 
 

4. Enter the details for the single journal entry transaction (e.g. EURO 

Conversion). 
 

5. Enter the Transaction Date. This date should be a date within your current 
financial year. 

 
6. Enter the Posting Date. This date should be a date within your current financial 

year. 
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7. Select the Tax Code for the single journal entry transaction. 
 

8. Enter the transaction’s Net Amount as calculated in step 1. 
 

9. If applicable, enter the transaction’s Tax Amount. 
 

10. Click on the Post button. 
 

 

 

The Check and fix balances option 
 

The check and fix balances is an automated process which can be used to adjust minor 
inaccuracies within customer, supplier and nominal account balances. These inaccuracies 

are a result of the decimal precision used during the conversion process as well as the 
applicable EURO conversion rate. 

 

 
 
To run this option, select the Tools tab and then click on the Check & Fix button. This 

option will only fix minor inaccuracies within customer, supplier and nominal account 
balances and does not fix the errors/warnings within the allocations and audit splits. 
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Technical Support 
 
For technical support, you may contact Garsys Software as follows: 

 
 

 Online: http://www.garsys.com 

 Email: support@garsys.com 
 Telephone: (356) 79429300 
 

 
To download the latest version of the product and related documentation, please visit our 

website. 
 

 
  

http://www.garsys.com/
mailto:support@garsys.com
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Frequently Asked Questions 
 
What is the Sage Euro Conversion Tool? 

The Sage Euro Conversion tool enables you to convert your Sage Line 50 V9 or V11 
transactions (client and supplier accounts, invoices, sales and purchase orders etc) to the 

respective EURO equivalents. The conversion process is simple: select your Sage Line 50 
dataset, configure your parameters (Sage Version, username and password) and then click 

on the convert button. It is important that you backup your Sage Line 50 dataset before 

converting your data. This enables you to restore your pre-conversion data whenever this 
may be required. 

 
Which versions of Sage are supported by the Sage Euro Conversion Tool? 

The Sage Euro Conversion Tool is compatible with Sage Line 50 v9 and Sage Line 50 v11. 
 

What are the minimum requirements for running the Sage Euro Conversion Tool? 
The minimum requirements for running the Sage Euro Conversion Tool are as follows: 

 

- Microsoft Windows 98/2000/XP (XP recommended) 
- Microsoft .NET Framework 2.0 

- 128Mb of RAM 
- Sage Line 50 v9 or v11 (must be installed on the same computer where the data 

conversion will be done) 
- Internet connection (required for the license activation process) 

 
Why is only one (1) company listed by the Sage Euro Conversion Tool? 

The number of companies listed by the Sage Euro Conversion Tool depends on the license 

that you purchased. To convert more than one company dataset you would need a multi-
company license. 

 
What are the differences between the standard and the pro licences? 

The standard license only enables you to convert one Sage Line 50 dataset while the pro 
license enables you to convert multiple Sage Line 50 dataset. 

 
What if the LM/EURO conversion rate changes? 

The official EURO conversion rate is 0.429300. This may, however, be changed from the 

configuration screen if required. 
 

Why isn’t my Sage Line 50 password saved? 
Your Sage Line 50 password is not saved by the Sage Euro Conversion Tool for security 

reasons. 
 

Why is the convert button disabled? 
To enable the convert button you need to activate your Sage Euro Conversion Tool license. 

 

What is license activation? 
License activation protects the intellectual property and innovation at the heart of the 

software industry. The process is aimed to eliminate unauthorised use of software in a 
manner designed to have a minimal impact on licensed users. The license information is 

sent to Garsys software through the means selected by the user (normally the internet), 
and once the license is verified, the product is activated and available for use. 
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What is the recommended procedure for converting my company data? 

The recommended procedure for converting your Sage Line 50 company data is as follows: 
 

1. Backup your Sage Line 50 data. 
 

2. Check your Sage Line 50 data for errors. To do this, while you’re logged in Sage 
Line 50 select the Maintenance option from the File menu and then click on the 

Check Data button. If any errors are reported by Sage, then click on the Fix 
button. 

 

3. If possible, it is recommended that you do a period-end (month-end or year-
end). To do this, select the respective option within the Period End option 

located within the Sage Line 50 Tools menu or consult your financial controller. 
 

4. We recommend that you take another backup of your Sage Line 50 dataset 
following the data maintenance process. 

 
5. Store the backups in a safe place in case these are needed following the data 

conversion process. 

 
6. Take note of a sample of your customer balances, supplier balances, cash and 

bank accounts and trial balance totals. 
 

7. Convert your data 
 

8. Backup your Sage Line 50 data using a different backup file name. 
 

9. Check your Sage Line 50 data for errors. To do this, while you’re logged in Sage 

Line 50 select the Maintenance option from the File menu and then click on the 
Check Data button. If any errors are reported by Sage, then click on the Fix 

button. (see note below) 
 

10. Store the backups in a safe place in case these are needed following the data 
conversion process. 

 
11. Take note of the same sample of your converted customer balances, supplier 

balances, cash and bank accounts and trial balance totals which you previously 

captured before the actual data conversion process. 
 

12. Compare the converted balances and totals with the pre-conversion balances and 
totals using the official conversion rate of 0.429300. 

 
 

Why am I getting a “Data files are wrong version” error message? 
The Sage Euro Conversion Tool is only compatible with Sage Line 50 v9 and Sage Line 50 

v11. Please ensure that you have selected the corrected Sage Line 50 version when 

connecting to your Sage Line 50 company dataset. 
 

 
Why am I getting an “Invalid or incorrect username or password” error message? 

Please ensure that your have entered the correct Sage Line 50 username and password 
before connecting to your Sage Line 50 company dataset. 
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How do I backup my Sage Line 50 company data? 

To backup your Sage Line 50 company data: 
 

1. Run Sage Line 50 and open your company data 
 

2. Select the Backup option from the File menu 
 

3. Select Yes to check your data. If you are sure that there are no inconsistencies 
within your data, then select No. 

 

4. Select the ALL Files option. 
 

5. Select a folder where to store the backup set. 
 

6. Type a name for your backup set in the File Name textbox. 
 

7. Click on the OK button. 
 

How do I restore my Sage Line 50 company data? 

To restore your Sage Line 50 company data: 
 

1. Run Sage Line 50 and open your company data 
 

2. Select the Restore option from the File menu 
 

3. Locate your backup set (file). 
 

4. Click on the OK button. 

 
5. If you are sure you want to restore your data and overwrite any data held in the 

current company, click on the Yes button. Otherwise click on No. 
 

Why does Sage Line 50 report errors/warnings following the data conversion 
process? 

Sage Line 50 may report a number of errors/warning following the conversion process. 
Moreover, Sage Line 50 may also complain that the nominal and trial balances are incorrect 

or do not match. These errors/warnings are mainly due to the conversion rate used during 

the conversion process. The inconsistencies between the allocation totals and related splits 
are due to the rounding mechanism used by Sage Line 50 and shouldn’t reflect any real 

problems within your Sage Line 50 dataset. 
 

How can I correct the errors/warnings reported by Sage Line 50? 
To correct the errors/warnings related to the nominal and trial balances can be fixed using 

the single entry journal posting utility as explained within this user guide. 
 

What is a single-sided journal entry? 

A single journal entry is used to correct the minor inaccuracies within the nominal and trial 
balances reported by Sage Line 50. 

 
How can I post single-sided journal entries? 

To post a single-sided journal entry, use the Journal Posting option within the Tools tab. 
Please also refer to the Posting Single Journal Entries within this user guide. 

 
Do you provide Sage integration services? 

Yes we do provide Sage integration services. For further information, please visit our 

website. 
 


